
    Welcome to Version 2.0 of StuffIt Deluxe™

About this Addendum
This manual addendum is provided in a double-clickable form, where you can 
now read and/or print this document.  If you just purchased StuffIt Deluxe, you 
received a printed copy of this addendum with your package.  If you received 
version 2.0 as an upgrade, this document should serve as your manual 
addendum.  If you want a printed copy for yourself, contact Aladdin Systems, 
and we’ll ship one off to you free of charge.

It is very easy to work with this documentation.  We’ve separated the major 
additions to StuffIt Deluxe into numerous chapters, which can be selected from 
the Chapters menu.  At any time, you can print the pages you’re reading (using 
the Print… command under the File menu) or Save the text of the addendum to 
a file that can be opened with any text editor or word processor (if you do this, 
however, you’ll lose the graphics used here.

New Features in 2.0
Version 2.0 furthers the many features within StuffIt Deluxe.  Most notable of 
our additions are tremendous speed boosts, intelligent compression through 
“Best Guess,” the ability for creation of Self-UnStuffing archives, a collection of 
StuffIt Tools, new Optimizers, and a new Encryptor.

A sampling of the many new features in the 2.0 package include:
  • An intelligent compression option, Best Guess
  • A new compression method, Optimal
  • The ability to create Self-UnStuffing archives
  • A Save As… command within the application
  • Automatic Launching of an application and a compressed document
  • An Optimizer that helps archiving of text files.
  • A MacPaint Optimizer that reduces the size of MacPaint files
  • PassLock, a password scheme for keeping sensitive files from prying eyes
  • Desk Accessories for Stuffing and UnStuffing from within any application
  • SIT Converter, an application for converting archives into a smaller form
  • HyperCard XCMDs for Stuffing and UnStuffing within HyperCard or
    SuperCard
  • MicroPhone II scripts for Stuffing/UnStuffing within that program
  • QuicKeys 2 extensions for the CE Software macro utility
  • MPW Tools for developers who need compression in their projects
  • A StuffIt XTND for reading the archive contents within an
    XTND-compatible app
  • Additions to the scripting language
  • And more!
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Contacting Aladdin Systems

At Aladdin Systems, we pride ourselves on the technical and customer support 
services we offer.  Besides providing support via mail, phone and through 
electronic mail, Aladdin Systems has a number of support forums on major 
online services.  These include America Online (keyword: ALADDIN), GEnie 
(in the MacRT), AppleLink (in the 3rd party section), and in early 1991, 
CompuServe.  We invite you to come visit us online and share in our lively 
discussions and software libraries (which contain scripts, technical notes, special 
utilities, and much more).

Aladdin Systems can be reach at the following address:
    Aladdin Systems, Inc.
    Deer Park Center
    Suite 23A-171
    Aptos, CA 95003
    United States of America
    (408) 685-9175

Our Technical Support Group is available Mon-Fri, 9am-5pm, Pacific time. You 
can also obtain electronic support by sending us electronic mail directly.  You 
can reach us via America Online (ALADDIN), CompuServe (75016,325), 
GEnie (ALADDINSYS), Internet (aladdin@well.uucp), or AppleLink 
(ALADDIN).
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New Compression Options - Best Guess & Optimal

Aladdin Systems has gone to great lengths to increase the compression results 
within StuffIt Deluxe version 2.0.  Version 2.0 introduces two new compression 
options: Best Guess and Optimal.

If you are too busy to select the different compression methods, we strongly 
recommend Best Guess.  Best Guess is designed for those users who want StuffIt 
Deluxe to quickly choose a great compression method.  Best Guess is different 
from StuffIt Deluxe’s Better.  Better works on several compression methods 
before choosing the best one to use, but takes more time than Best Guess.

Optimal is the name of an entirely new compression method that can be found in 
StuffIt Deluxe 2.0.  Aladdin named the compression method Optimal because it 
provides an exceptional balance between compression size and speed.  Optimal’s 
performance time is outstanding.  In fact, Optimal offers compression results 
that are in between the ranges of Fast and Better. 

These new options are available whenever selecting the compression method 
from the StuffIt Deluxe application (in Expert menus), Magic Menu, Desk 
Accessories or any other application that uses StuffIt Deluxe’s compression 
engine.  

StuffIt Deluxe’s scripting language has new options added to the stuff and 
quickstuff commands to support these new options.  When you need to select 
a compression option for either of these two commands, you can use the 
keyword optimal for Optimal compression and guess for using the Best 
Guess compression option.
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Additions to the Application

Self-UnStuffing Archives
StuffIt Deluxe allows you to create archives that can be sent to people who do 
not have StuffIt Deluxe or StuffIt Classic to UnStuff the archive.  These files are 
called Self-UnStuffing archives and they are made by first creating an archive 
and then attaching a “Self-UnStuffer” to that archive.  This creates an archive 
that is a application that can be double-clicked at the Finder.

There are two ways to create a Self-UnStuffing archive.  The first, and easiest 
method is to use the “Self-UnStuffer” menu command.  After you create the 
archive, choose the Add Standard sub-menu from Self-UnStuffer (in the 
Other menu).  This turns the current archive into a Self-UnStuffing one, while 
the next method always saves a second, Self-UnStuffing, version of the archive.  

The second method for creating a Self-UnStuffing archive is to use the Save 
As… command.  As you are working with the archive you want changed, 
choose Save As… from the File menu.  At the bottom of the Save As… 
dialog will be the Create Self-UnStuffing Archive pop-up menu.  Simply 
select Standard from this pop-up menu, type a new name for your file and 
click Save.  In a few moments, a Self-UnStuffing archive will be saved to your 
disk.  

Regardless of the method used, you’ll see an Add Custom option available.  
This option is used to install specialized Self-UnStuffers to an archive.  These 
specialized Self-UnStuffers are available to vendors who wish to distribute 
software in a compressed form.  

 

                                                           The Self-UnStuffer pop-up menu in the Save As… dialog

Any time you wish to remove the Self-UnStuffer from an archive, open the 
archive and choose Remove from the Self-UnStuffer hierarchical menu.  
When this is done, the archive will no longer be a double-clickable application 
and can be used just as any other archive.

If you are interested in automating the creation of Self-UnStuffing archives 
through a script, look at the section on the Save As… command.

Software developers, publishers, VARs, and other vendors who wish to 
distribute software in a Self-UnStuffing format need to have a license from 
Aladdin Systems.  With a license, Aladdin will send you a custom Self-UnStuffer
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for your distribution.  Aladdin also provides other types of installers and 
Self-UnStuffers that work across multiple disks and perform other tasks (such as 
installing software to a designated location).  Contact Aladdin Systems for more 
information.

The “Save As…” Command
StuffIt Deluxe now has a Save As… command that can be found under the File 
menu.  Even though it works like most Save dialogs, StuffIt Deluxe’s Save 
As… command can be used for three things.  First, it can be used to save 
multiple copies of the current archive to another disk location.  Second, it may 
be used to create a “read only,” or locked, copy of the archive.  Third, it can 
also be used to make a Self-UnStuffing archive, as described in the previous 
section.
 
 

                                                                                            The Save As… dialog

When you select Save As… from the File menu, you get a Save dialog that is 
similar to Save dialogs in other applications.  At the bottom of this dialog are the 
Archive Options.  The first option is the pop-up menu for creating 
Self-UnStuffing archives.  The other option is a check box for creating a Read 
Only archive.

The Read Only option locks the archive, guaranteeing that the archive will never 
be changed with any operation such as Stuffing into the archive, copying to the 
archive, or trying to rename or delete an entry.  Once an archive is Read Only, 
you can unlock it only by saving the archive again without the Read Only option.
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The Save As command has a scripting equivalent. Its syntax and usage is as 
follows:
Save As <path:name> [read only][replace][Self-UnStuffing]
The readonly option locks the archive being saved.  Using the replace 
option will delete any existing archive (as long as it isn't locked).  Using the 
Self-UnStuffing option will install a standard UnStuffer.

(Note: The Self-UnStuffing keyword will always attach a standard 
Self-UnStuffer and never a custom one.)

Automatic Launching Documents
To make the process of using compressed files easier, Aladdin included an 
automatic launching feature in StuffIt Deluxe version 2.0.  The automatic 
launching feature works for any archive that has a single file.  The automatic 
launching feature is used from the Finder, where holding down the option key 
when double-clicking on the archive has StuffIt Deluxe quickly UnStuff the 
single file before opening that file with the application that created it.

  

                                  The Automatic Launching Preferences Setting

There is a pop-up menu Preferences setting (found in the Preferences dialog) 
for whether the option key should be pressed for this feature to work.  If this 
setting is “Option key pressed”, the feature works as just described.  If the 
setting is “Option key not pressed”, then all archives that have single files will 
take advantage of the automatic launching feature — all without touching the 
option key.

If the file within the archive is an application and not a document, the 
application will be UnStuffed and then launched.  If an archive contains more 
than one file, the status of the option key doesn’t make any difference - the 
archive will simply be opened within the StuffIt Deluxe application.
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The Text Optimizer
Text files obtained from large online services are notorious for having extra 
characters, such as spaces and tabs, that add unnecessary bulk to a file.  In the 
Macintosh world, some text editing programs add their own resources to text 
files that do not alter the information there.  The “Text 1” Optimizer alters or 
disposes of this unneeded data without removing essential text.  (Other examples 
of where this optimizer can prove valuable is on some non-Macintosh text files 
that use spaces to align text in columns and programmers products, like MPW 
Pascal that add scores of peripheral information to a text file.)

Upon selecting “Text 1” from the Optimizers dialog (in Expert menus, from 
either the Options menu or from a Stuff or QuickStuff dialog), you’ll see this 
dialog:

  

                                            Text 1 Optimizer Dialog

Each option will perform its own actions.  Simply check each action on or off 
and the next time a text file is compressed, the specified options will be used.  
Let’s closely examine them one at a time.
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Convert Leading Spaces to Tabs
If there are spaces that precede text, this option will change them to tab 
characters.  For example, where ‘◊’ is a space and ‘<tab>’ is a tab, using the 
“Convert leading spaces to tabs” option, will do the following:

                                    "◊◊◊◊◊◊◊◊This is a test"
                                            -changes to-
                                   "<tab><tab>This is a test"

This leading space option requires that you specify how many tab characters will 
be substituted.  In the previous example, it was specified that 4 spaces equal one 
tab.  Since some word processors and text editors store that information in the 
text file’s resources, the “Read tab settings from file” option does what it says; it 
looks to see if the file contains that information and, if it does, it gets used.  
Otherwise, the “Default tab:” option is used.

Strip Linefeeds
When you are typing in your word processor and hit the return key at the end of 
a paragraph, a character called a carriage return is inserted.  A number of word 
processing programs will let you look at these characters, sometimes showing 
them with a paragraph symbol (¶).  There are, however, some files that come 
from other computer systems that have another special character on each line, 
usually following the carriage return.  This character is called a linefeed.

Older computer printers required two actions for each time a new line needed to 
be placed on paper.  First, the carriage return would move the print head back 
to the start of the line and then the linefeed would advance the paper to the next 
line.  Fortunately, linefeed characters are not used on the Macintosh, but may 
still be around from other files that came from other computer systems.

The strip linefeeds option will remove these unnecessary characters from a file, 
thereby reducing the file size before the general compression begins.  Simply 
check the “Strip linefeeds” option and they will be removed.  A secondary 
option is available that looks for these linefeeds where they are most often 
expected, after a carriage return.  This “after CR only” option defaults to on, 
but you can turn it off if all linefeeds should be removed from a file.

Strip Trailing Spaces or Tabs
Sometimes, the author of a text file will accidentally add additional spaces or 
tabs at the end of a line or paragraph.  Since these extraneous characters are 
almost never needed, we include a “Strip trailing spaces or tabs” option for 
removing these characters.  Simply check this option and the Text 1 Optimizer 
will do the rest.
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Delete Resources
Macintosh files can be made up of two parts: data and resources.  The data 
portion of a file contains application-specific information, while the resource

part contains individual resources, which are types of formatted information that 

are consistent in structure.  An example of data vs.  resources is the placement 
of tab settings within a file, as discussed previously.  The actual text information 
of any text file will always be found in the data part of a file and 
Macintosh-specific formatting information, like tabs and fonts, get saved as 
resources in the resource portion of a file.

Since the valuable portion of a text file is the actual text information within the 
data fork, it is possible to delete resources from a text file without altering the 
text.  That is exactly what the “Delete resources” option does.

The option is of great value to programmers who find significant amounts of 
compiler information, such as symbol tables, in text file resources.  When 
archiving, it doesn’t make a difference that these tables have been removed 
because the next time the file is compiled, the information is fully rebuilt.

If you are not a programmer, you will also find value in this option.  All 
unnecessary information within a text file’s resources can be removed without 
altering the text at all.

The MacPaint Optimizer
StuffIt Deluxe comes standard with “MacPaint 1”, an Optimizer that works on 
MacPaint® files.  MacPaint, a graphic software package from Claris, is well 
known to Macintosh users as one of the first pieces of software available for the 
Macintosh; in fact, it came with every Macintosh back in 1984.  It allows for 
black and white bitmap painting inside a canvas area that is about the size of a 
letter-sized page.

Besides Claris’ MacPaint 2.0, there are a number of other painting programs 
that can save files in MacPaint format such as Apple’s HyperCard®, Silicon 
Beach’s SuperPaint™, Electronic Arts Studio/1™, and CE Software’s Amazing 
Paint™.

The MacPaint 1 Optimizer works on a file by removing data that is not 
required.  The MacPaint 1 Optimizer will never remove artwork from a 
document and will achieve its best results when using Best Guess or Better 
compression.   The painting palette and pattern settings along with current
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selection are examples of the type of information that gets removed with this 
Optimizer.  The next time you enter into MacPaint, the palette and patterns will 
use default settings.  

The Optimizer may be turned on and off as shown in the StuffIt Deluxe User’s 
Guide (pg.  143).  Usage, as with any Optimizer, is designed to be transparent.  
Just turn the MacPaint Optimizer on and StuffIt Deluxe will take care of the 
rest.

Who Engineered This?
The “Text 1” and “MacPaint 1” Optimizers were written by Robert “The 
Optimizer” Gibson.  Robert is a college student who also wrote a killer utility — 
WhereSIT — for the older StuffIt software.  We expect that you’ll hear many 
great things from Robert in the future.  You can write to Robert and tell him 
how much disk space he saved you c/o Aladdin Systems.
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PassLock Encryptor
Attention International Users: While NewDE and DES is not supported with 
your StuffIt Deluxe, PassLock is installed for your use.  It is the security scheme 
to use when sending files to any StuffIt Deluxe user.

There are often times that you wish to quickly password protect a file, but do 
not wish to wait through the time it takes to perform the encryption.  For this 
reason, we include the PassLock Encryptor.  Just like other Encryptors, you can 
access them only in Expert menus.

PassLock simply attaches a password to an archive and secures any file(s) with 
that password.  The file is not, unlike NewDE and DES, then further encrypted 
or scrambled to guarantee its security.  However, files are normally “scrambled” 
when they are compressed, so you may not mind this lack of security.

Securing a file with PassLock couldn’t be easier.  If you wish to activate 
PassLock from a menu, choose “Custom Encryption…” and a dialog will appear 
where you designate PassLock as your Encryption method.  If you wish to use 
PassLock when Stuffing a file , select “Custom…” from the Encryption pop-up 
in any Stuff dialog.

Working with the passwords for PassLock is like working with any other 
passwords.  The actual process is described on pages 97-100 in the StuffIt 
Deluxe User’s Guide.  As always, don’t forget your password as there is no way 
for anyone at Aladdin Systems to recover protected archives.  

PassLock was written by the most secure man alive, Richard Outerbridge.  
Thank you for all of your contributions, Rich.
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StuffIt Desk Accessories
Two desk accessories are included with StuffIt Deluxe.  They can be found in 
Font/DA Mover suitcases inside the StuffIt Tools folder within the StuffIt 
Deluxe Folder.  You need to use the Font/DA Mover application (that came 
with your Macintosh) to install the desk accessories.  For information on using 
Font/DA Mover, consult your Macintosh Owner’s Guide.  Once a desk accessory 
is installed, it is available under the Apple menu.

Stuff File… Desk Accessory
The Stuff File… desk accessory is used to compress a single file into a new 
archive.  When you select “Select File…” from the Apple menu, you’ll see a 
dialog that asks you which file you want to Stuff.

 

 

                                                                         The Stuff File… Desk Accessory dialog

Within this dialog, simply select the file to be compressed and click on the 
“Stuff” button.  The file will be Stuffed into a new archive that is named the 
same as the file with the “.sit” designator at the end of the archive name.  If you 
wish to name the archive something else, click on the “Stuff As…” button and 
you’ll be prompted for a new archive name.  

UnStuff File… Desk Accessory
The “UnStuff File…” desk accessory lets you UnStuff an entire archive or an 
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individual item from within it.  This desk accessory has a special feature that 
makes it very easy to get to any entry within an archive — if you can use an 
Open dialog, you can UnStuff anything.  With this feature, archives are treated 
just like folders on your disk, you can enter into these archives and see what is 
contained within - UnStuffing only what you need at the moment.

 
   

                                                                              UnStuff File… Desk Accessory Dialog

 

                                                           UnStuff File… Desk Accessory Dialog (inside an archive)
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If you want to UnStuff an entry from within an archive, begin by choosing 
“UnStuff File…” from the Apple menu and navigate (in this Open dialog) to the 
archive that contains the item you want UnStuffed.  (The upper dialog shows 
how we have just selected the archive).  Notice the “Go Into Archives” checkbox 
at the bottom of the dialog.  When this is checked, you can click on the “Open” 
button (or double-click on the archive) and you’ll find yourself inside the 
archive (as shown in the bottom dialog).

Once inside the archive, all files and folders will be shown in black, reminding 
you that they are still compressed.  As soon as you click on the “UnStuff” 
button, the file or folder selected will UnStuff and you’ll be able to use it 
normally.

If your goal is to UnStuff an entire archive, uncheck the “Go Into Archives” 
option and, instead of entering archives, they will UnStuff when you open them.

A separate Aladdin product, Shortcut, provides this “Go Into Archives” feature 
within every application.  This way, every archive is treated like a folder and all 
of your UnStuffing can be done transparently.
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The SIT Converter Mass Conversion Application

A special application, “SIT Converter”, is provided to make it easy to convert 
archives from one compression method to another.  It can also be used to change 
1.5.1 archives into StuffIt Deluxe archives while also improving their 
compression.

SIT Converter is very easy to use.  First, you choose the new compression 
method from the Compression menu.  Then use either the “Convert Archive…” 
(c-O) or “Convert Folder…” (c-F) command from the File menu to specify the 
archives to be converted.

If you are interested in converting a number of archives at one time, the 
“Convert Folder…” provides that functionality.  Prior to using this command, 
you may want to organize a number of archives to be converted en masse into a 
single folder.  By selecting “Convert Folder…”, you cause a dialog to appear 
asking which folder contains the archives you wish converted.
 
 

                                          Convert Folders…dialog

This dialog is very similar to an Open dialog found in most applications with the 
exception that it works on folders and not individual files.  You must navigate to 
the appropriate folder and click on the “Convert Current Folder” button (or 
select any archive within that folder).  You’ll then see the SIT Converter 
application UnStuff each archive entry and Stuff it once again, this time using 
the compression option you specified.

The “Convert Enclosed Folders” option at the bottom of this dialog allows you 
StuffIt Deluxe 2.0 Addendum Page  15 SITConverter Application



to convert every single archive within the folder, even if it is within other 
folders.  If you have unchecked this option, only archives in that folder level 
will be acted upon.

The SIT Converter application has another menu, appropriately named Options, 
that has you further specify how SIT Converter should work.  In this menu, you 
can select among three options for which type of archives you need converted: 
”All Archives”, “1.5.1 Archives Only”, or “Deluxe Archives Only”.  The other 
option available is “Delete Original Archive”.  Toggling this option on has 
StuffIt Deluxe erase the source archive after the conversion has taken place.

Since SIT Converter will create a new archive (it uses the existing filename with 
the word “New” at the beginning), there must be free space on the startup disk 
for the conversion to work.

SIT Converter was written by Robert “Piece o’ Cake” Ulrich.  If you like SIT 
Converter as much as we do, you can write to Robert c/o Aladdin Systems.
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HyperCard XCMDs
HyperCard®, from Apple Computer and Claris Corporation, has its own type of 
external modules, called XCMDs.  These externals are also supported by a few 
other applications such as SuperCard™ by Silicon Beach, Plus™ from 
Spinnaker, and MicroPhone™ II from Software Ventures to mention a few.  We 
have included XCMDs with StuffIt Deluxe so that these applications (and others 
that support XCMDs) can have compression abilities added to them.

We supply you with two separate XCMDs: Stuff and UnStuff.  These XCMDs 
allow you to create StuffIt Deluxe archives as well as decompressing both StuffIt 
Deluxe/Classic and StuffIt 1.5.1 archives.  The XCMDs require the presence of 
the ‘StuffIt Engine™’ which has already installed as part of the StuffIt Deluxe 
package.  If the Engine is not present, these XCMDs will not work, and will 
return an error in the HyperCard error container, theResult.

We supply the HyperCard XCMDs inside a HyperCard stack called “StuffIt 
XCMDs”.  It is a fully working stack that you can use to find out more about 
our XCMDs and test them as well.

To place the Stuff and UnStuff XCMDs in your own stacks, you need to use a 
resource copier such as ResCopy or ResEdit.  Once these XCMDs are in your 
own stack, they are part of the HyperTalk language and can be accessed like any 
other command.

The Stuff XCMD
The Stuff XCMD has the following syntax: 
     Stuff archiveName, fileName, compressionType
archiveName is a full pathname (including path and filename) for the new 
archive you want created.  fileName is a full pathname (also including 
filename) to a plain text file which contains a carriage return(<CR>) delimited 
list of files and folders to be archived.  The last option, compressionType is 
either an integer or a string which is used to represent the type of compression 
to use, where: none = 0, faster = 1, fast = 2, better = 3, optimal = 4, 
(Best) guess = 5

The UnStuff XCMD
The UnStuff XCMD has a very basic syntax as follows: 
                UnStuff archiveName
archiveName is a full pathname for the archive you want UnStuffed.  If there 
are multiple items in the archive, the contents of the archive are placed into a 
new folder called “archiveName Folder”. This is similar to how QuickUnStuff 
and Magic Menu works.
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Credit Where Credit is Due
The Stuff and UnStuff XCMDs are Copyright © 1990 by Leonard Rosenthol and 
Lazerware, Inc.  The HyperCard stack that contains the XCMDs was written by 
Bill Woodcock and Leonard Rosenthol.  Much thanks to you guys! Outstanding 
job.

If you have any comments, suggestions, etc.  for these XCMDs, please send them 
to Aladdin Systems or directly to the author at: Leonard Rosenthol, Software 
Ventures, 2907 Claremont Ave., Berkeley, CA 94705; GEnie: MACgician; 
AOL: MACgician1; Internet: leonardr@sv.portal.com OR svc@well.UUCP; 
AppleLink: D0025.

MicroPhone II Scripts
Since the MicroPhone II telecommunications software is able to access 
HyperCard XCMDs, we’ve included various MicroPhone II scripts for Stuffing 
and UnStuffing without leaving the MicroPhone application.  The XCMDs are 
built into the “StuffIt Scripts” settings file, so you just need to do “Open 
Settings…” within MicroPhone II to use the scripts.

When the StuffIt Scripts settings file is opened, you’ll notice that the 
MicroPhone II script palette has four buttons in it.

 

                                      StuffIt Scripts command palette

Stuffing within MicroPhone II is done by first establishing a ‘batch’ file that 
contains a listing of all the files you want to be Stuffed.  Each line within the 
batch file should contain the entire pathname and filename for the file(s) to be 
Stuffed.  (A sample batch file is included, too).  Once that is done, clicking on 
the “Stuff A Batch” button will have MicroPhone ask you where the file is that 
contains the batch.  After instructing it where the file is, the Stuff XCMD will 
take over, Stuffing all the files in the batch.  New archives are created similar to 
the QuickStuff command within StuffIt Deluxe - the “.sit” suffix will be added to 
the filename being compressed.

UnStuffing an archive can be done one of two ways.  The “UnStuff A File” 
button asks you for a single archive to UnStuff, while the “UnStuff a Folder” 
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asks you to designate a folder which contains numerous archives that you wish 
UnStuffed in one step.  Archives are UnStuffed in a manner like QuickUnStuff 
within the application - a folder with the archive name is created and all entries 
are placed into it.

These MicroPhone II scripts were written and are Copyright © Leonard 
Rosenthol and Lazerware, Inc.  Should you wish to contact him, you can find 
him at the address mentioned in the proceeding StuffIt XCMDs section.  Again, 
thanks Leonard.  
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QuicKeys 2 Extensions
QuicKeys 2 is a popular (and very handy) software utility from CE Software.  It 
is essentially a macro program that can record your actions and replay them by 
typing a keystroke.  One of its many features allows for extensions (much like 
StuffIt Deluxe’s open architecture) to be added at any time, bringing more 
functionality to the product.  When you get your QuicKeys 2 diskette, our Stuff 
and UnStuff extensions are automatically installed and ready to be used.  We 
include the same QuicKeys extensions with our package, too.  If you do not use 
QuicKeys 2, you can trash the QuicKeys 2 Extensions folder.

Since the QuicKeys 2 manual contains detailed information on working with 
extensions, we’ll just provide an overview on how the Stuff and UnStuff 
extensions work.

With QuicKeys 2 and the StuffIt extensions, you can establish as many 
Stuff/UnStuff variations as you wish, from backup sets that can be invoked each 
time you startup your Macintosh to a single key that asks you what files to 
compress and every combination in between.

The Stuff Extension 
 

                                  The QuicKeys 2 Stuff Extension dialog
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The Stuff Extension lets you specify two general options: the archive to Stuff 
into and the items that are to be Stuffed into it.  With the first option, you can 
have QuicKeys always prompt you for the archive name (as is checked in the 
previous dialog) or click on the “Select Archive” button to specify the name of a 
new archive that is to be used.  The “Overwrite Existing” option will have the 
Stuff Extension replace an old archive with a new one, should it already be on 
disk.

The “Default Source Items…” button brings up a dialog that is similar to the 
Multiple Stuff dialog with the StuffIt Deluxe application.  Here, you can set up a 
consistent set of files that you always want archived.  If no items are specified, 
the QuicKeys will ask you for the files each time it is invoked.

The other options in this dialog are standard QuicKeys 2 options and are 
described in the QuicKeys 2 User’s Guide.

The UnStuff Extension
 
 

                               The QuicKeys 2 UnStuff Extension dialog

The UnStuff Extension only lets you opt for whether a designated archive is to 
be UnStuffed (using the “Select Archive” button) or if you should be prompted 
each time for which archive should be UnStuffed on disk.
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StuffIt XTND
Claris Corporation devised a file conversion mechanism for its software, call 
XTNDs.  XTNDs are also used by other software developers to utilize foreign 
file formats without ‘reinventing the wheel.’ Today, users of MacWrite II can 
simply choose Open… to access files created on IBM-PC’s, and this is done 
using XTNDs.

We include an XTND that produces a listing of the files within an archive.  To 
use this StuffIt XTND, you must already be using some XTND-compatible 
software, such as Claris’ MacWrite II or On Technology’s On Location™.  
Then, you’ll be able to determine the contents of an archive quickly and easily 
within these products.  If you don’t have a need for the StuffIt XTND, simply 
delete it from your disk; it can always be installed later.

Simply place the StuffIt XTND inside the Claris Translator folder (which can be 
found within the System Folder).  Once that is done, the StuffIt XTND is 
available for other programs to use.  The actual use of the XTND depends on 
the program; consult with that programs User’s Guide for detailed information.

Users of On Location can use the StuffIt XTND so that the files within archives 
can be indexed and accessible with a search.  The “OL File Kinds” text file must 
be changed to reflect this ability.  Simply open the “OL File Kinds” document 
with any text editor or word processor, and erase the line that currently says 
‘SIT!  - StuffIt archive’.  Then, add these two lines in its place:
           SIT!<tab><tab>*<tab>StuffIt 1.5 archive
           SITD<tab><tab>*<tab>StuffIt Deluxe archive

You’ll then have to reindex the hard disk(s) that contains the archives you want 
to work with.  The next time you use On Location and you need to locate a file 
within an archive, click on the “Text” radio button and type the name of the file.  
Within seconds, you’ll see the archive listed.
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MPW Tools
The Macintosh Programming Workshop (MPW) is a development environment 
from Apple Computer for writing software for the Macintosh.  It, like StuffIt 
Deluxe, has an open architecture where new modules may be added at any time.  
Since many programmers use StuffIt Deluxe in their daily archiving, we now 
include MPW Tools that can be integrated into any MPW script.  Users of 
MPW, should move the two StuffIt MPW tools (Stuff and UnStuff) into their 

MPW Tools folder.  If you do not use MPW, you should trash the “StuffIt MPW 
Tools” folder since you do not need them.

Both MPW tools are commando-compatible, so typing “Stuff…” or “UnStuff…” 
will bring up a commando dialog.  Within that dialog, all parameters are fully 
explained and help is available there for further information.
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Other Changes

Enter/Change Password

Version 1.0 of StuffIt Deluxe has two separate password (“Enter Password” and 
“Change Password”) commands on the File menu.  This 2.0 release combines 
both commands into the single “Enter Password” command and it is now placed 
under the Other menu.  

By combining these two commands, very little functionality is lost.  The only 
thing you cannot do now is to enter a password for decryption prior to doing an 
UnStuff.  This used to afford you the ability to open an archive, enter a 
password and then UnStuff.  Now, you need to UnStuff first, then enter the 
password when prompted.  

Erasing Floppies While Segmenting

When segmenting files across multiple floppy disks, the 1.0 version of StuffIt 
Deluxe did not provide you with a quick and easy way to clear disk space during 
the segmenting process.  Now, when you are segmenting to diskettes, you will 
see a “Erase Floppy” button.  Clicking on the button will erase the diskette 
currently being used.  

There are some safety features which will prevent you from deleting something 
you needed.  First, after clicking the button, you will be warned and asked once 
again if you are sure you wish to erase that disk.  Secondly, StuffIt Deluxe 
prevents you from erasing a hard disk or removable media.  Only diskettes may 
be erased.
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                                           The Erase Floppy button

Variable Substitution for Scripts
With the 1.0 version of StuffIt Deluxe, you were not able to write scripts that 
could work on any user’s machine.  This is because exact pathnames were 
required and if one person’s hard disk is called “HD” and another is called “Hard 
Disk,” StuffIt Deluxe would only work for the disk name that was explicitly 
specified.  With the 2.0 release, we now introduce some basic variables for 
getting around this problem.

These variables may be used within any command that requires a pathname, such 
as new archive, stuff, or even binhex to name a few.  Variables must be enclosed 
within brackets ({}) to be recognized correctly.  These variables include
       {startup}, {system}, {deluxe}, {date}, and {time}.

{startup} specifies the name of the startup disk. {system} is the pathname 
to the active System Folder name.  This pathname includes the disk name as 
well, so when you need to UnStuff into the active System Folder, just use the 
{system} variable.  The {deluxe} variable designates the path to where StuffIt 
Deluxe is installed.

Two other variables are provided to assist you in creating unique names of new 
archives and items that are UnStuffed. The {date} variable adds the date to
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the filename, while {time} adds the current time to a filename.  Dates and 
times are delimited with periods (11.09.91) and not the usual slashes (10/09/91)

An example of usage is when you backup your files daily, but you want each 
archive name to be unique so that earlier archives are not overwritten.  Here, 
you would specify:

        new archive "backup {date}.sit"

and the archive would be named “backup 11.09.91.sit”

Since braces are specially used in scripts, you must place a backslash (\) before 
any brace you want to be taken literally.  For example, if a script contained 
“\{time}” will be interpreted as “{time}” without any variable substitution.

Creating 1.5.1 Archives With Scripts
The new archive and quickstuff script commands now let you create 
1.5.1-compatible archives.  If you wish to do this, the new 1.5.1 option is 
expected at the end of the script command line.  For example, the script 
command,

       new archive "my archive.sit" 1.5.1

will make this new archive have a 1.5.1 format.  It is important to remember 
that 1.5.1 archives only support fast compression and no external optimizers, 
encryptors, or compressors can be used.

Previous versions of StuffIt Deluxe utilized a classic option instead of the 1.5.1 
option.  All older scripts that specify a classic option in a new archive or 
quickstuff command will have to have that option changed to 1.5.1 to have the 
same effect.

Aborting Scripts
Prior to this release, StuffIt Deluxe would always abort a script when it 
encountered an error such as misspelled commands, incorrect options, or other 
problems.  There are times, when writing scripts, for example, that you may 
wish to have StuffIt Deluxe continue after it encounters an error.  That is why 
we now provide the continue on error command.

The continue on error command would normally be placed at the 
beginning of a script.  Thereafter, whenever an error is then encountered, 
StuffIt Deluxe will attempt to execute subsequent commands.  Use this command
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only if you are sure that the commands that follow do not depend on the one that 
may have aborted with an error.

Another new command, abort on error, is what StuffIt Deluxe currently 
defaults to: the aborting of a script upon any error.  You can now explicitly 
specify for StuffIt Deluxe to stop executing a script when an error occurs.  We 
provide the abort on error command to work hand-in-hand with the 
continue on error command.  Using these two together will allow you to not 
abort a script for certain commands, while aborting for others.  The only 
command that will never be aborted is the quit command.  

Replace or Prompt on Segmenting or Joining
The scripting language has always had a prompt option for the segment and 
join commands.  Using prompt will have StuffIt Deluxe bring up a dialog 
asking for the files to be processed with each command.  Version 2.0 adds a 
replace option that can be used instead of the prompt option.  

If there is a possibility that files may already exist on disk that will cause StuffIt 
Deluxe to prompt the user for further input, the replace option will prevent 
StuffIt Deluxe from bringing up the “Replace file with same name?” dialog.  
This option, when used with the segment command is very useful for automating 
backups.

Detection of New Viruses
Since the original release of StuffIt Deluxe, a few new viruses have surfaced.  In 
addition to the viruses that were detected previously, Version 2.0 now detects 
MDEF (the various kinds), ANTI (with A and B mutants), CDEF, and the 
“Frankie” viruses.  We still provide you with the most recent version of 
Disinfectant™ (at the time of our shipping this version) and the latest version of 
Disinfectant is able to detect and remove the previous viruses mentioned.  The 
Disinfectant utility can be found on Disk Two.
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More on StuffIt Deluxe
Q: What are the folders that get placed in my System Folder?

A: See pages 151-154 of the StuffIt Deluxe User’s Guide for detailed 
information on what each folder is used for.

Q: What is the StuffIt Engine? How do I use it?

A: The StuffIt Engine is a special file that resides in the Extension Folder in 
your System Folder.  It is the nuts and bolts behind what makes StuffIt Deluxe 
work.  In fact, the way we let Microphone II, White Knight and other 4th 
parties “talk” to StuffIt Deluxe is through this ‘Engine.’ You never have to go 
out of your way to “use” the Engine.  Whenever it’s in the proper folder, the 
application you’re using will find and use it by itself.  In this 2.0 version of 
StuffIt Deluxe, all of the “Supplemental” parts of the package (such as the desk 
accessories and the XCMDs, for example) use the StuffIt Engine religiously.

Q: What folders can I remove from my System Folder and still use all of the 
features of StuffIt Deluxe?

A: If you want to use EVERY feature of StuffIt Deluxe, each folder is required.  
However, if you never use the help facility, just trash the Help folder; if you 
never use any Optimizers, trash the Optimizers folder.

The only golden rule are that you should NEVER remove the “StuffIt Engine™” 
from the Extensions folder.  It is also strongly recommended that the “StuffIt 
Deluxe Preferences” file be kept in the Preferences folder.  These two files 
must, for the large part, always be around for StuffIt Deluxe to use.

Q: I do not like my System Folder cluttered more than it already is.  Am I able 
to put all the external files in just one folder?

A: Yes, and no.  Just as previously stated, the “StuffIt Engine™” must always be 
in the Extensions folder within your System Folder.  The StuffIt Deluxe 
application looks in a few locations for your externals.  First, StuffIt Deluxe will 
search in the individual folders in the System Folder.  If StuffIt Deluxe cannot 
find the externals there, it will then look for them in the same folder as the 
“StuffIt Deluxe Preferences” file.  If no externals are there, StuffIt Deluxe will 
look in the same folder as the StuffIt Deluxe application.

Of course, like every rule, there are exceptions.  Help files must be in the “Help” 
folder and Viewers must be in the “Viewers” folder (if you want all software to
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find them properly).  As well, StuffIt Deluxe expects the “Extensions” folder to 
remain as it installs on your disk.

Q: Why do my StuffIt Deluxe archives have generic icons and the icons are 
different on my friend’s Macintosh?

A: An older version of StuffIt was on your disk at some time and deposited its 
icon.  Please remove all previous versions of StuffIt and rebuild your desktop by 
holding down the command (c) and Option keys as the Macintosh is starting up.  
CAUTION: This will permanently erase all ‘Get Info…’ Finder comments from 
all files.

Q: Can I send StuffIt Deluxe archives to my friends who have StuffIt Classic 1.6 
or StuffIt Classic 1.5.1.

A: Yes, and no.  The StuffIt Classic 1.6 format is the same as StuffIt Deluxe’s 
file format.  The people who have these versions can exchange archives freely.  
The StuffIt Deluxe archive format is an improved and different format than 
StuffIt 1.5.1.  Owners of StuffIt 1.5.1 are encouraged to upgrade to StuffIt 
Classic 1.6 or StuffIt Deluxe so that they can use all files that are posted 
worldwide.

StuffIt Classic is still shareware and version 1.6 was sent to all registered users 
for free.  In the interim (while people still have version 1.5.1) you may want to 
use the “Create 1.5.1 Archive” when creating archives.
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